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Reference to the whole or to part of this volume should be made as follows: 
Print citation for Chapter 1:
Shipboard Scientific Party, 2003. Leg 202 summary. In Mix, A.C., Tiedemann, R., Blum, P., et al., Proc. 
ODP, Init. Repts., 202: College Station TX (Ocean Drilling Program), 1–145.

CD-ROM volume citation:
Mix, A.C., Tiedemann, R., Blum, P., et al., 2003. Proc. ODP, Init. Repts., 202 [CD-ROM]. Available from: 
Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2003. Leg 202 summary. In Mix, A.C., Tiedemann, R., Blum, P., et al., Proc. 
ODP, Init. Repts., 202, 1–145 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for 
available volumes and Web citation formats. 

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: October 2003

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 174AX Supplement (Initial Reports): February 2003

Volume 201 (Initial Reports): May 2003
Volume 203 (Initial Reports): June 2003
Volume 174A (Scientific Results): February 2003
Volume 177 (Scientific Results): March 2003
Volume 183 (Scientific Results): June 2003

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 

Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 

TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph is a SeaWiFS image of central Chile that shows visible plumes of river outflow. The 
sediment-laden plumes extend ~70 km into the Pacific Ocean, boosting phytoplankton production as 
they pass. The snow-covered Andes Mountains are visible along the right side of the image. The 
capital city of Santiago is the grayish sploch west of the Andes at ~33.5°S. Image provided by 
ORBIMAGE. © Orbital Imaging Corporation and processing by NASA Goddard Space Flight Center.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 

countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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OCEAN DRILLING PROGRAM*
National Science Foundation
4201 Wilson Boulevard
Arlington VA 22230, USA
Tel: (703) 306-1581; Fax: (703) 306-0390
Web site: www.nsf.gov

MEMBER ORGANIZATIONS OF THE JOINT OCEANOGRAPHIC INSTITUTIONS FOR DEEP EARTH 
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Florida State University
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University of Florida
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Science and Technology
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Science, and the Arts

University of Rhode Island, Graduate School of 
Oceanography

University of South Florida, College of Marine 
Science

University of Texas at Austin, Institute for 
Geophysics

*At time of publication. See Publisher’s Notes, p. 5, for list of funding agencies at time of cruise. For an up-to-date list of
current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.

http://www.nsf.gov/
http://www.oceandrilling.org/
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University of Washington, College of Ocean and 
Fishery Sciences

Woods Hole Oceanographic Institution

Australia/Canada/Chinese Taipei/Korea 
Consortium for Ocean Drilling: Department of 
Primary Industries and Energy (Australia), 
Natural Resources Canada, National Taiwan 
University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

European Science Foundation Consortium for 
Ocean Drilling (Belgium, Denmark, Finland, 
Iceland, Ireland, Italy, The Netherlands, Norway, 
Portugal, Spain, Sweden, and Switzerland)

Federal Republic of Germany, Bundesanstalt für 
Geowissenschaften und Rohstoffe

OCEAN DRILLING PROGRAM (ODP)

Web site: www.oceandrilling.org

ODP SCIENCE ADVISORY STRUCTURE 
(JOIDES)

JOIDES Office
University of Miami—RSMAS
4600 Rickenbacker Causeway
Miami FL 33149, USA
Tel: (305) 361-4668; Fax: (305) 361-4632
E-mail: joides@rsmas.miami.edu
Web site: joides.rsmas.miami.edu
France, Institut National des Sciences de 
l’Univers–Centre National de la Recherche 
Scientifique (INSU-CNRS)

Japan, University of Tokyo, Ocean Research 
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People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 

ODP PROGRAM MANAGER

Joint Oceanographic Institutions, Inc.
1755 Massachusetts Avenue, NW, Suite 700
Washington DC 20036-2102, USA
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@joiscience.org
Web site: www.joiscience.org

http://www.oceandrilling.org/
mailto:joides@rsmas.miami.edu
http://joides.rsmas.miami.edu
mailto:joi@joiscience.org
http://www.joiscience.org
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ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547, USA
Tel: (979) 845-2673; Fax: (979) 845-4857
E-mail: odp@odpemail.tamu.edu

ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
of Columbia University

PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
Web site: www-odp.tamu.edu

ODP LOGGING SERVICES OPERATOR

Borehole Research Group
Lamont-Doherty Earth Observatory 
of Columbia University

PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8341; Fax: (845) 365-3182
E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP

Web site: www.ldeo.columbia.edu/databank

mailto:odp@ldeo.columbia.edu
mailto:odp@odpemail.tamu.edu
http://www-odp.tamu.edu/
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
http://www.ldeo.columbia.edu/databank
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs) and smear slide and thin section data tables are included in this 
section. ASCII versions of the smear slide data tables are also available (see “ASCII Tables”). 

Site 1232
Visual Core Descriptions · Smear Slides 

Site 1233
Visual Core Descriptions · Smear Slides

Site 1234
Visual Core Descriptions · Smear Slides 

Site 1235
Visual Core Descriptions · Smear Slides 

Site 1236
Visual Core Descriptions · Smear Slides 
Site 1237
Visual Core Descriptions · Smear Slides 

Site 1238
Visual Core Descriptions · Smear Slides

Site 1239
Visual Core Descriptions · Smear Slides 

Site 1240
Visual Core Descriptions · Smear Slides 

Site 1241
Visual Core Descriptions · Smear Slides 

Site 1242
Visual Core Descriptions · Smear Slides
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of composite depth scale, splice tie point, magnetic 
susceptibility, and age model data tables from the site chapters and all of the smear slide data tables 
presented under “Core Descriptions.” A complete listing of the ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 

on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program but not directly 
from PDF files.

Chapter 3 Chapter 7 Chapter 11 

Chapter 4 Chapter 8 Chapter 12 

Chapter 5 Chapter 9 Chapter 13 

Chapter 6 Chapter 10 Smear slide data tables
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Chapter 3, Site 1232
Table T2. Composite depth scale, Site 1232.
Table T3. Splice tie points, Site 1232.
Table T4. OSUS-MS measurements, Hole 1232A.
Table T5. OSUS-MS measurements, Hole 1232B.
Table T7. Coarse-grained layers, Site 1232.

Chapter 4, Site 1233
Table T2. Primary composite depth scale, Site 1233
Table T3. Primary splice tie points, Site 1233.
Table T4. Secondary composite depth scale, Site 1233.
Table T5. Secondary splice tie points, Site 1233.
Table T6. OSUS-MS measurements, Hole 1233A.
Table T7. OSUS-MS measurements, Hole 1233B.
Table T8. OSUS-MS measurements, Hole 1233C.
Table T9. OSUS-MS measurements, Hole 1233D.
Table T10. OSUS-MS measurements, Hole 1233E.

Table T20. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1233.

Chapter 5, Site 1234
Table T2. Composite depth scale, Site 1234.
Table T3. Splice tie points, Site 1234.
Table T4. OSUS-MS measurements, Hole 1234A.
Table T5. OSUS-MS measurements, Hole 1234B.
Table T6. OSUS-MS measurements, Hole 1234C.

Chapter 6, Site 1235
Table T2. Composite depth scale, Site 1235.
Table T3. OSUS-MS measurements, Hole 1235A.
Table T4. OSUS-MS measurements, Hole 1235B.
Table T5. OSUS-MS measurements, Hole 1235C.
Table T6. Splice tie points, Site 1235.
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Chapter 7, Site 1236
Table T2. Composite depth scale, Site 1236.
Table T3. Splice tie points, Site 1236.
Table T4. OSUS-MS measurements, Hole 1236B.
Table T5. OSUS-MS measurements, Hole 1236C.
Table T14. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1236.

Chapter 8, Site 1237
Table T2. Composite depth scale, Site 1237.
Table T3. Splice tie points, Site 1237.
Table T4. OSUS-MS measurements, Hole 1237A.
Table T5. OSUS-MS measurements, Hole 1237B.
Table T6. OSUS-MS measurements, Hole 1237C.
Table T7. OSUS-MS measurements, Hole 1237D.
Table T21. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1237.

Chapter 9, Site 1238
Table T2. Composite depth scale, Site 1238.

Table T3. Splice tie points, Site 1238.
Table T4. OSUS-MS measurements, Hole 1238A.
Table T5. OSUS-MS measurements, Hole 1238B.
Table T6. OSUS-MS measurements, Hole 1238C.
Table T16. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1238.

Chapter 10, Site 1239
Table T2. Composite depth scale, Site 1239.
Table T3. Splice tie points, Site 1239.
Table T4. OSUS-MS measurements, Hole 1239A.
Table T5. OSUS-MS measurements, Hole 1239B.
Table T6. OSUS-MS measurements, Hole 1239C.
Table T16. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1239.
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Chapter 11, Site 1240
Table T2. Composite depth scale, Site 1240.
Table T3. Splice tie points, Site 1240.
Table T4. OSUS-MS measurements, Hole 1240A.
Table T5. OSUS-MS measurements, Hole 1240B.
Table T6. OSUS-MS measurements, Hole 1240C.
Table T7. OSUS-MS measurements, Hole 1240D.
Table T20. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1240.

Chapter 12, Site 1241
Table T2. Composite depth scale, Site 1241.
Table T3. Splice tie points, Site 1241.
Table T4. OSUS-MS measurements, Hole 1241A.
Table T5. OSUS-MS measurements, Hole 1241B.
Table T6. OSUS-MS measurements, Hole 1241C.
Table T16. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1241.

Chapter 13, Site 1242
Table T2. Composite depth scale, Site 1242.
Table T3. Splice tie points, Site 1242.

Table T4. OSUS-MS measurements, Hole 1242A.
Table T5. OSUS-MS measurements, Hole 1242B.
Table T6. OSUS-MS measurements, Hole 1242C.
Table T7. OSUS-MS measurements, Hole 1242D.
Table T17. Age-depth model, linear sedimentation rates, and mass accumulation rates, Site 1242.

Smear Slide Data Tables
Site 1232 smear slide table.
Site 1233 smear slide table.
Site 1234 smear slide table.
Site 1235 smear slide table.
Site 1236 smear slide table.
Site 1237 smear slide table.
Site 1238 smear slide table.
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Site 1239 smear slide table.
Site 1240 smear slide table.
Site 1241 smear slide table.
Site 1242 smear slide table.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary data files of equivalent logging depths for Sites 

1238 and 1239 and secondary splice and affine data files for Site 1233. The equivalent logging depth 
data are presented in FORTRAN-formatted ASCII files in a form readable by Sagan software (version 
1.2). The splice and affine data are ASCII files in a format readable by the software program Splicer 
(version 2.2).

ELD

1238.TXT
1239.TXT
README.TXT

SPLICER

1233_AFF.TXT
1233_SPL.TXT
README.TXT
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 202 Site Map 

ODP Map (Legs 100–202)

DSDP Map (Legs 1–96)
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RELATED LEG DATA
DOWNHOLE LOGGING AND CORE DATA 

A CD-ROM containing processed logging data and a subset of core data is included with the printed 
version of this volume. However, a more complete set of the logging data collected by ODP Logging 
Services is available online at www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html. If 
you have problems downloading the data, wish to receive additional logging data, or have questions 
regarding the data, please contact: Data Services Manager, ODP Logging Services, Borehole Research 
Group, Lamont-Doherty Earth Observatory of Columbia University, PO Box 1000, 61 Route 9W, 
Palisades NY 10964, USA; Tel: (845) 365-8343; Fax: (845) 365-3182; E-mail: 
logdb@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html
mailto:logdb@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–178, 180, and 183. The indexes are contained 
in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes 
can be searched individually or collectively.
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

202IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR202_01.PDF (Leg 202 Summary)VOLUME
(Leg 202 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps)

ODPMAP.PDF
(ODP map, Legs 100 through 202)

CHAPTERS
(Volume chapters)

202_MAP.PDF
(Leg 202 site map)

IR202_02.PDF (Explanatory Notes)

IR202_03.PDF (Site 1232)

IR202_04.PDF (Site 1233)

IR202_05.PDF (Site 1234)

IR202_06.PDF (Site 1235)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

(Continued on next page)

APPENDIX
(Volume appendix)

APPENDIX.PDF (Nonmagnetic Core Barrel) 

COR_1232.PDF (Site 1232)CORES
(Visual core descriptions and smear
slide data tables and digital 
core images)

COR_1233.PDF (Site 1233)

COR_1234.PDF (Site 1234)

IMAGES (PDF files of core images)

IR202_07.PDF (Site 1236)

IR202_08.PDF (Site 1237)

COR_1235.PDF (Site 1235)

COR_1236.PDF (Site 1236)

COR_1237.PDF (Site 1237)

MAC

UNIX

WINDOWS

IR202_09.PDF (Site 1238)

IR202_10.PDF (Site 1239)

IR202_11.PDF (Site 1240)

IR202_12.PDF (Site 1241)

IR202_13.PDF (Site 1242)

COR_1238.PDF (Site 1238)

COR_1239.PDF (Site 1239)

COR_1240.PDF (Site 1240)

COR_1242.PDF (Site 1242)

COR_1241.PDF (Site 1241)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 178NDX.PDF,
180NDX.PDF, and 183NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

SUPP_MAT
(Supplementary Material)

ELD 
(Equivalent logging depth data in
FORTRAN-formatted ASCII files)

1238.TXT 

VOLUME
(Continued)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
202 Initial Reports)

TABLES
(ASCII versions of composite depth
scales and splice tie points and
magnetic susceptibility and smear 
slide data tables)

IR202_03 (Site 1232)

IR202_04 (Site 1233)

IR202_05 (Site 1234)

IR202_10 (Site 1239)

S_SLIDES (Sites 1232 through 1242)

README.TXT

IR202_08 (Site 1237)

IR202_09 (Site 1238)

IR202_07 (Site 1236)

IR202_06 (Site 1235)

IR202_13 (Site 1242)

IR202_11 (Site 1240)

IR202_12 (Site 1241)

README.TXT

1239.TXT 

SPLICER 
(Secondary splice and affix data in 
Splicer-formatted ASCII files)

1233_AFF.TXT

README.TXT

1233_SPL.TXT
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